256-Color Support in OLE 2.0 Containers

PSS ID Number: Q98872
Authored 16-May-1993 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.0
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SUMMARY

If a client application draws a 256-color object in OLE version 1.0,
the palette is always realized and used during the OleDraw command. As
a result, the palette from the last object displayed is always used,
causing previously drawn objects to update poorly.

In OLE version 2.0, OleDraw does not realize the palette
automatically. Instead, a container must call
IViewObject::GetColorSet () to retrieve the logical palette for each of
its displayed objects. With this information, the container can
construct a palette that best suits all of its displayed objects.

MORE INFORMATION

To get the equivalent of OLE 1.0 functionality in an OLE 2.0
container, IViewObject::GetColorSet must still be used to get a
logical palette for an object, and in turn a palette must be created
and realized from this information.

The following C++ function demonstrates the implementation of a
drawing routine for an OLE 2.0 container that behaves similar to an
OLE 1.0 client application.

Sample Code

void DrawObject (LPOLEOBJECT 1pOleObject)

{
LPVIEWOBJECT lpViewObject;

// Get a pointer to IViewObject.
1pOleObject->QueryInterface (IID IViewObject,
(LPVOID FAR *) &lpViewObject);

// If the QI succeeds, get the LOGPALETTE for the object.
if (lpView)
lpView->GetColorSet (DVASPECT CONTENT, -1, NULL, NULL, NULL,
&pColorsSet) ;



HPALETTE hPal=NULL;
HPALETTE hOldPal=NULL;

// If a LOGPALETTE was returned (not guaranteed), create the
// palette and realize it. Note: A smarter application
// would want to get the LOGPALETTE for each of its visible
// objects, and try to create a palette that satisfies all of the
// visible objects. Also, OleStdFree() is use to free the
// returned LOGPALETTE.
if ((pColorSet))
{
hPal = CreatePalette((const LPLOGPALETTE) pColorSet);
hOldPal = SelectPalette (hDC, hPal, FALSE);
RealizePalette (hDC) ;
OleStdFree (pColorSet) ;
}

// Draw the object.
OleDraw (m_ 1lpOleObject, DVASPECT CONTENT, hDC, &rect);

// 1If we created a palette, restore the old one and destroy
// the object.
if (hPal)

{

SelectPalette (hDC, hOldPal, FALSE) ;

DeleteObject (hPal) ;

}

// If a view pointer was successfully returned, it needs to be
// released.
if (lpView)

lpView->Release() ;
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Adding Type Libraries as Resources to .DLL and .EXE Files

PSS ID Number: Q122285
Authored 01-Nov-1994 Last modified 21-Apr-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.02

A type library can be added as a resource to an .EXE or .DLL file by using
the following statement in the .RC file:

1 typelib TEST.TLB
TEST.TLB is the type library to be added as a resource.

If a type library is added as a resource, a separate .TLB file need not be
shipped with the application. LoadTypelLib () and LoadRegTypelLib () can be
used to load the type library from the .EXE or .DLL file in which it exists
as a resource.

NOTE: OLE version 2.02 or higher is needed to read a type library from an
.EXE file.
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BUG: (I)CntrOutl Does Not Set Target Device Information

PSS ID Number: Q108310
Authored 08-Dec-1993 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

During the print process from (I)CntrOutl, a server application is asked to
render its display with the TARGETDEVICE structure set to NULL instead of
containing a valid structure. This implies that (I)CntrOutl wants a screen
representation rather than a printed representation of the object.

CAUSE

(I)CntrOutl is not filling out the TARGETDEVICE structure; it prefers to
use a screen representation on the printer, rather than request the printed
presentation.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
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BUG: Accelerator Causes Crash in ISvrOutl Embedded in C12Test

PSS ID Number: Q108311
Authored 08-Dec-1993 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

After embedding an ISvrOutl object in Cl2Test or Cl32Test, pressing the
ALT+BACKSPACE accelerator (Undo) results in a general protection (GP) fault
within ISvrOutl.

STATUS

Microsoft has confirmed this to be a problem in the Cl2Test (Cl32Test) test
application. We are researching this problem and will post new information
here as it becomes available.

Additional reference words: 2.01 3.50 4.00 Outline Server Inplace GPF gp-
fault crash

KBCategory: kbole kbbuglist

KBSubcategory: LeTwoTls



BUG: Borland WINSIGHT Causes GP Faults w/ Some OLE Sample

PSS ID Number: Q112410
Authored 08-Mar-1994 Last modified 21-Apr-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

If Borland's WINSIGHT tool is running when you start some of the sample
applications that have been included in the OLE 2.01 SDK, a general
protection (GP) Fault will occur before the main application window
appears.

The following OLE 2.01 SDK sample applications are affected:

cl2test.exe
sr2test.exe
outline.exe
cntroutl.exe
svroutl.exe
icntrotl.exe
isvrotl.exe

STATUS

Microsoft has confirmed this to be a problem in the OLE SDK version 2.01.
We are researching this problem and will post new information here in the
Microsoft Knowledge Base as it becomes available.

Additional reference words: 2.01 toolkit gpf gp-fault buglist2.01
KBCategory: kbole kbbuglist
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BUG: Cannot Paste Link SR2TEST Object in OLE 1.0 Client

PSS ID Number: Q108932
Authored 20-Dec-1993 Last modified 17-May-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51
- Microsoft Windows 95

SYMPTOMS

The Paste Link option is not available in an OLE 1.0 client application
after copying an unsaved SR2TEST object to the clipboard.

CAUSE

SR2TEST is not setting the OLEMISC CANLINKBYOLEl bit in the Link Source
Descriptor that it places onto the clipboard.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

Additional reference words: 2.01 3.50 4.00 test
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: CL2TEST Does Not Display Prompt String from GetCurFile()

PSS ID Number: Q111014
Authored 03-Feb-1994 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

IPersistFile::GetCurFile() returns S FALSE to indicate that the document
has no currently associated file. In this case, GetCurFile() returns the
default prompt string for the filename (as would be displayed in the Save
As dialog box under the File menu) in the lplpszFileName parameter.

When CL2TEST calls IPersistFile::GetCurFile (), and GetCurFile() returns
S _FALSE, CL2TEST fails to display the returned prompt string.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

MORE INFORMATION

To call IPersistFile::GetCurFile() on an object embedded in CL2TEST, click
the object using the right mouse button, choose PersistFile Method from the
pop-up menu, then choose GetCurFile.

Additional reference words: 2.01 3.50 4.00 95 Toolkit
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BUG: CL2TEST Fails to Parse Filenames with Extended

PSS ID Number: Q109548
Authored 04-Jan-1994 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

When attempting to insert a new embedded object from a file, CL2TEST fails
with the error STG E FILENOTFOUND if the filename or directory name
provided contains an extended character.

STATUS

Microsoft has confirmed this to be a problem with the CL2TEST sample
application in the Object Linking and Embedding Software Development Kit
(SDK) version 2.01. We are researching this problem and will post new
information here as it becomes available.

This problem does not occur with 32-bit OLE.

MORE INFORMATION

To insert a new embedded object from a file into a CL2TEST document, from
use CL2TEST's Insert menu, choose Embed From File.

Additional reference words: 2.01 toolkit buglist2.01
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: CL2TEST Handles Icon Aspect Incorrectly

PSS ID Number: Q111339
Authored 09-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

Selecting the iconic aspect when inserting an object in CL2TEST results in
the object being created and displayed with the content aspect.

CAUSE

CL2TEST is passing the DVASPECT CONTENT flag to the embedded object when
calling IViewObject::Draw. The correct flag to pass is DVASPECT ICON.

STATUS

Microsoft has confirmed this to be a problem in the CL2TEST test
application included with the Object Linking and Embedding SDK version
2.01. We are researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

MORE INFORMATION

To specify a custom FORMATETC when inserting an object into CL2TEST, choose
the "Select FormatETC" button found on CL2TEST's Create Invisible dialog
box (from the Insert menu, choose Object).

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: CL2TEST Not Properly Activating Links to Embedded

PSS ID Number: Q111340
Authored 09-Feb-1994 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

Double-clicking a link to an embedded object in CL2TEST results in the
activation remaining on CL2TEST. The correct action would be for the
container of the embedded object to obtain the activation and edit the
object visually (if possible).

STATUS

Microsoft has confirmed this to be a problem in the Object Linking and
Embedding SDK version 2.01.

This is not a problem with the Visual C++ 2.x CL32TEST under Windows NT
3.5.

Additional reference words: 2.01 toolkit buglist2.01
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: CreateFromTemplate of OLE 2 Object into OLE 1 Container

PSS ID Number: Q111595
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An OLE 2.01 or later object is inserted into an OLE 1.0 container using
OleCreateFromTemplate () . The OLE libraries start the server, but then the
object creation fails, or a blank object is created.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: Deleting an Open Packager Object Causes GP Fault

PSS ID Number: Q108931
Authored 20-Dec-1993 Last modified 15-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

Deleting an object from within the Object Packager results in a general
protection (GP) fault.

CAUSE

The object is being edited in its server as a result of double-clicking the
Content window. Deleting the object while in this state causes the Object
Packager to GP fault.

STATUS

Microsoft has confirmed this to be a problem in Object Packager version
2.01. We are researching this problem and will post new information here as
it becomes available.

This problem does not occur on Windows NT 3.5, with Object Packager 3.5.
Additional reference words: 2.01 GPF gp-fault crash

KBCategory: kbole kbbuglist
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BUG: DIB Can Be Returned Only on TYMED_HGLOBAL

PSS ID Number: Q98679
Authored 11-May-1993 Last modified 17-May-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.0
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51
- Microsoft Windows 95

SYMPTOMS

IDataObject::GetData returns DV_E FORMATETC when requesting a
device-independent bitmap (DIB) from an OLE object.

CAUSE

The DIB must be returned in a STGMEDIUM of type TYMED HGLOBAL.

RESOLUTION

Add TYMED HGLOBAL to the tymed member of the FORMATETC structure being
passed to IDataObject::GetData.

STATUS

Microsoft has confirmed this to be a problem the Microsoft products listed
at the beginning of this article. We are researching this problem and will
post new information here in the Microsoft Knowledgebase as it becomes
available.

Additional reference words: 2.00 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoDdc



BUG: Embedded Object's Size Changes When it Is Run

PSS ID Number: Q110872
Authored 01-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

A non-running embedded object is resized in an OLE 2.01 container
application. The next time the object is run, it snaps back to its previous
size.

CAUSE

The container application failed to call IOleObject::SetExtent () after
calling OleRun() .

RESOLUTION

IOleObject::SetExtent () can be called only when an object is running. If an
object is resized while it is not running, the container application should
take note of this. When the object is subsequently run, the container
should then inform the object of its new size by calling

IOleObject: :SetExtent () .

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base when it
becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoCdt



BUG: First Entry in Paste Special Dialog Is Blank

PSS ID Number: Q110798
Authored 28-Jan-1994 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

The first format entry in the Paste Special dialog box is blank after
copying an OLE2Link object from an OLE 1.0 client to the clipboard.

NOTE: An OLE2Link object is created by the OLE 1.0 compatibility layer when

an OLE 2.0 link is copied from an OLE 2.0 application to the clipboard, and
then pasted into an OLE 1.0 client application.

CAUSE

The CLSID and lpszFullUserTypeName of the OBJECTDESCRIPTOR structure are
left blank by the OLE 1.0 compatibility layer.

STATUS

Microsoft has confirmed this to be a problem in the OLE libraries version
2.01. We are researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

This is not a problem in 32-bit OLE.
Additional reference words: 2.01 buglist2.01

KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: Iconic OLE Object Prints as Black Rectangle on

PSS ID Number: Q110796
Authored 28-Jan-1994 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

Calling OleDraw () or IViewObject::Draw() to print an iconic OLE object to a
PostScript printer results in a black rectangle being drawn.

CAUSE

Internally, the OLE DLLs (dynamic-link libraries) are using the DrawIcon ()
function to draw the icon. DrawlIcon () requires the target device to support
the SRCINVERT ROP (raster operation) code. PostScript does not support this
particular ROP code.

RESOLUTION

An application can call OleDraw() or IViewObject::Draw() using a memory DC
(device context). A bitmap of the memory DC can be retrieved, which can be
used with the BitBlt () function to get the correct output to the printer.

STATUS

Microsoft has confirmed this to be a problem in the OLE Libraries version
2.01.

This is not a problem in 32-bit OLE.
Additional reference words: 2.01

KBCategory: kbole kbbuglist
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BUG: IEnumUnknown Is Not Remoted

PSS ID Number: Q110799
Authored 28-Jan-1994 Last modified 21-Apr-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

All calls to IOleContainer::EnumObjects () fail.

CAUSE

IO0leContainer: :EnumObjects () returns a pointer to IEnumUnknown. The current
implementation of OLE does not include remoting code for the IEnumUnknown
interface. There is no proxy and stub code, therefore the methods in this
interface cannot be marshaled to another process.

STATUS

Microsoft has confirmed this to be a problem in the OLE Libraries version
2.01. We are researching this problem and will post new information here in
the Microsoft Knowledge Base as it becomes available.

Additional reference words: 2.01 buglist2.01
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoCdt



BUG: Insert Object from Zero Length File Causes GP Fault

PSS ID Number: Q108371
Authored 09-Dec-1993 Last modified 15-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

Creating an object from a zero length file that does not have a valid file
class extension results in a general protection (GP) fault after displaying
the message, "Not enough memory to perform this operation. Close one or
more applications and try again."

CAUSE

When creating an object from a file that does not have a valid class
extension, the Object Packager is invoked to generate the embedded object.
In the case of a zero length source file, the Packager document-level DDE
window is rendered invalid before a terminate message can be sent to it.

STATUS

Microsoft has confirmed this to be a problem in the Object Linking and
Embedding (OLE) libraries version 2.01.

While the operation still fails with Object Packager 3.5 under Windows NT
3.5, the Object Packager provides a better error message.

Additional reference words: 2.01 gpf gp fault
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: Invisible MSDRAW Object Retains Keyboard Focus

PSS ID Number: Q110715
Authored 27-Jan-1994 Last modified 25-May-1995

The information in this article applies to:

- Microsoft OLE version 1.0
- Microsoft OLE Libraries for Windows and Win32s, versions 2.0 and 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, version 3.5

SYMPTOMS

When an invisible MSDRAW object is inserted as an OLE embedded object,
the object retains the keyboard focus. This behaviour is incorrect. The
MSDRAW object should not take the focus until it has been made visible.

This problem occurs whether the MSDRAW object is inserted into an
OLE 1.0 client application or into an OLE 2.0 container application.

STATUS

Microsoft has confirmed this to be a problem with MSDRAW version 1.0. We
are researching this problem and will post new information here as it
becomes available.

Additional reference words: 1.00 2.00 3.50
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoApp



BUG: IOleCache::Cache Returns Incorrect Error Value

PSS ID Number: Q110488
Authored 24-Jan-1994 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An OLE 2.0 container application calls IOleCache::Cache for a particular
FORMATETC and is returned the value OLE S FORMATETC NOTSUPPORTED. A
subsequent call to IOleCache::Cache with the same FORMATETC returns
CACHE S SAMECACHE.

CAUSE

The OLE 2.0 server application has a message filter installed and is
rejecting all incoming calls. The default object handler cannot get the
information from the server to fill the cache, but the cache is still
created. A more appropriate return value would be

OLE S SOMECACHES NOTUPDATED.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

Additional reference words: 2.01 3.50 4.00 95
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoPrs



BUG: IOleCache::Cache(), ADVF_DATAONSTOP, and OLE 1.0 Objects

PSS ID Number: Q111614
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An OLE 2.0 container application document contains an embedded OLE 1.0
object. The container calls IOleCache::Cache() to control the cached
presentation data for the object, and specifies ADVF DATAONSTOP as the
advise flag to Cache (). The user makes some changes to the object in the
OLE 1.0 server, then attempts to update the object's presentation in the
server by choosing the Update command from the File menu. Finally, the user
closes the object server.

In this specific scenario, the object's presentation in the server is not
updated. The object's native data, however, is correct.

CAUSE

When the user selects Update, the presentation for the object does not go
across to the cache or the container, because the container specified
ADVF DATAONSTOP as the cache option. As part of the update operation, the
server internally marks the object as "not dirty". Because the object is
not dirty, when the server is subsequently closed, it does not send any
data to the container or the cache.

RESOLUTION

Container applications should not specify the ADVF DATAONSTOP flag when
calling IOleCache::Cache(). Instead, they should specify ADVFCACHE ONSAVE.
When ADVFCACHE ONSAVE is used, the OLE 1.0 object's cached presentation
data will be updated correctly.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoPrs






BUG: I0leObject::Close(OLECLOSE_NOSAVE) and DoVerb()

PSS ID Number: Q111577
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An OLE 2.0 container application inserts a new embedded object into a
document. The container calls IOleObject::Update() on the object to update
the cache, then calls IOleObject::Close(OLECLOSE NOSAVE) to transition the
object back to the running state. Finally, the container tries to rerun the
object by calling IOleObject::DoVerb() .

In this particular scenario, DoVerb() will return STG _E FILENOTFOUND, and
the object will not be rerun.

CAUSE

Because the container specifies OLECLOSE NOSAVE when calling Close (), the
object is never saved to persistent storage. However, the object has
internally been marked as not being a brand new object. Consequently, when
the container calls DoVerb (), the object's handler calls
IPersistStorage::Load () on the object, attempting to put the object into
the running state. This call will fail, because the object has never been
saved.

RESOLUTION

The solution to this problem is for the container to specify
OLECLOSE_SAVEIFDIRTY when calling Close().

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

Additional reference words: 2.10 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoCdt



BUG: IROT::Register() and IOL::SetDisplayName() Inconsistency

PSS ID Number: Q111607
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

IRunningObjectTable: :Register () allows monikers that are not valid
filenames to be registered as file monikers. However, if the display name
string passed to IOlelLink::SetSourceDisplayName () is not a valid filename,
SetSourceDisplayName () returns STG E FILENOTFOUND.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

MORE INFORMATION

This inconsistency may become apparent when an OLE application is calling
IOleLink: :SetSourceDisplayName () to change the source of a link object. It
is possible that a new file moniker that is not a valid source name will be
registered on the running object table--for example, a moniker of "New 1"
for a new, as yet unsaved document. It will not be possible to use
SetSourceDisplayName () to link to this object, however, because "New 1" is
not a valid filename, and therefore it will be rejected by
SetSourceDisplayName () .

Additional reference words: 2.01 3.10 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwolLnk



BUG: Object Packager GPFs w/ Paths Greater Than 64 Characters

PSS ID Number: Q109116
Authored 21-Dec-1993 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
SYMPTOMS

Packaging an object that has a fully qualified path of more than 64 letters
results in a general protection (GP) fault in the Object Packager.

CAUSE

MS-DOS paths have a limit of 64 characters. The Object Packager does not
correctly handle scenarios that involve File Manager paths greater than
this limit.

STATUS

Microsoft has confirmed this to be a problem in the Windows 3.1 Object
Packager.

This problem does not occur with Object Packager 3.5 on Windows NT 3.5.
MORE INFORMATION

Steps to Reproduce

1. Create a directory structure in File Manager that results in a path
greater than 64 characters. You must use File Manager because MS-DOS
will not allow a directory structure this large to be created.

2. Use File Manager to copy a file into this new subdirectory. File Manager
must be used because MS-DOS will not recognize this directory.

3. Select the file from within File Manager.
4. Choose Copy from the File menu.

5. Choose the Copy To Clipboard button to place the filename and path on
the clipboard.

6. Launch CntOutl and Paste Link.

Additional reference words: 2.10 3.10 GPF GP-Fault buglist2.01
KBCategory: kbole kbbuglist



KBSubcategory: LeTwoApp



BUG: OLE 1.0 Server Launched for Paste Link

PSS ID Number: Q111578
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An OLE 1.0 server application copies an object to the clipboard, then
enters the blocked state. An OLE 2.0 container application then attempts to
paste a link to the object from the clipboard. The OLE 2.0 application is
frozen.

Next, the OLE 1.0 application is shut down. This unfreezes the OLE 2.0
container application, which proceeds to paste the link to the OLE 1.0
object. However, an instance of the OLE 1.0 server is launched. Normally,
the server is not run in a paste-link scenario.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

Additional reference words: 3.10 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: OLE 2.0 Compatibility Layer Uses Document IDataObject

PSS ID Number: Q111585
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

Whenever the OLE 1.0 client compatibility layer uses IDataObject, it uses
the OLE 2.0 server's document-level data object rather than the server's
pseudo-object data object.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

MORE INFORMATION

One of the side-effects of this problem is that the following key is
required in the OLE 2.0 server application's CLSID listing in the
registration database

GetSet
|- X =3, 1, 32, 1

where X is application-dependent. If this key is missing from the
registration database, then any attempt to embed the OLE 2.0 object into an
OLE 1.0 client will fail, even if the server application fully supports
IDataObject: :EnumFormatEtc.

The GetSet key is used by server applications to describe the formats that
an object is capable of rendering, or having set. OLE looks at this key
when it needs to know which formats an object supports, without having to
run the object. This key is required in this situation because the OLE 1.0
compatibility layer is always going to refer to the registration database
to enumerate the formats supported by the server application. This
particular key represents the METAFILEPICT format, which must be supported
for OLE 1.0 compatibility.

Additional reference words: 2.01 3.50 4.00 toolkit
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoPrs






BUG: OLE 2.0 Containers & 1.0 Objects that Close w/out Saving

PSS ID Number: Q109547
Authored 04-Jan-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE version 1.0
- Microsoft OLE Libraries for Windows and Win32s, versions 2.0 and 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

When an OLE 1.0 object is inserted into an OLE 2.0 container document and

then closed without an update being invoked, the correct streams for that

object are not written to storage. Any subsequent attempt by the container
to load the object will fail.

CAUSE

When the OLE 1.0 object is closed without an update, the OLE 2.0 container
receives an IAdviseSink::0nClose () message without having first received an
IClientSite::SaveObject () message. Unless the container takes steps to work
around this problem, incorrect streams will be saved.

RESOLUTION

To protect against this scenario, OLE 2.0 containers that want data to be
available after an OLE 1.0 object closes without updating can implement
code similar to the following pseudocode:

OleCreate () ;

OleRun () ;

IOleObject: :Update () ; \\ To get a snapshot of the data.
OleSave () ; \\ To save the data to storage.

IOleObject::DoVerb () ;

Alternatively, the container could just delete any objects that call
IAdviseSink::0nClose () without first calling IClientSite::SaveObject().

STATUS

Microsoft has confirmed this to be a problem in the products listed at the
beginning of this article. We are researching this problem and will post
new information here as it becomes available.

MORE INFORMATION



For more information about known idiosyncrasies of embedding or linking OLE
1.0 objects into OLE 2.0 containers, please see the "Compatibility with OLE
1.0" section of the OLE SDK Help file.

Additional reference words: 1.00 2.00 2.01 3.50 4.00 toolkit
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: OLE 2.0 Does Not Support CF_OWNERDISPLAY

PSS ID Number: Q109552
Authored 04-Jan-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

If an application places a data transfer object onto the clipboard and that
data object enumerates CF _OWNERDISPLAY as one of the clipboard formats, the
application will not receive the WM PAINTCLIPBOARD message.

CAUSE

The WM PAINTCLIPBOARD message is sent to the clipboard owner in order to
paint the clipboard viewer window. After performing an OleSetClipboard,
clipboard ownership belongs to the OLE libraries. Because no window handle
information is passed with OleSetClipboard, the OLE libraries cannot
forward this message to the calling application.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoDdc



BUG: OLE Type Emulation for Previously Loaded Objects

PSS ID Number: Q111608
Authored 14-Feb-1994 Last modified 25-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

OLE type emulation is the process that allows the application user to
specify that all objects of some particular type are henceforth to be
activated as objects of some alternate, emulating type. When objects of the
original type are subsequently run, the server for the emulating type is
launched to serve them.

However, this emulation does not occur for objects of the original type
that were already in the loaded state when the type emulation occurred.
When such objects are subsequently run, they are run as the original type,
not the emulating type. The original server is launched, not the server for
the emulating type.

CAUSE

When an object is in the loaded state, its object handler is running. The
handler is, in general, particular to the original type for that object,
and therefore cannot emulate another object type.

STATUS

Microsoft has confirmed this to be a problem with the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

MORE INFORMATION

If a container application has previously loaded instances of the original
type, it should reload each such object as the alternative, emulating type
the next time that object is run.

For more information on OLE type emulation, see "Emulating Different Object
Types" in the Object Linking and Embedding Software Development Kit (SDK)

version 2.01 "Programmer's Reference" help file.

Additional reference words: 2.01 3.50 4.00 95
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BUG: OleConvertStorageToOOLESTREAM() Fails When CLSID Is NULL

PSS ID Number: Q111611
Authored 14-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

The OleConvertStorageToOLESTREAM () API (application programming interface)
call is used to convert the storage of an embedded object from the OLE 2.0
storage model to the OLE 1.0 storage model. However, if the OLE 2.0 object
has a CLSID of NULL, then OleConvertStorageToOLESTREAM() fails with a
return code of OLE E CLASS.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

MORE INFORMATION

Note that it is unusual for an embedded object to have a CLSID of NULL.
However, after IOlelLink::SetSourceDisplayName () has been called to change
the source of an embedded link object, it is possible for that link object
to have a CLSID of NULL.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoPst



BUG: OleCreate and IOleCache::Cache Fail with Multiple TYMEDs

PSS ID Number: Q109543
Authored 04-Jan-1994 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

The OLE 2.01 creation functions [OleCreate (), OleCreateFromData (), and so
forth] and IOleCache::Cache() fail if multiple values are specified for the
TYMED field of the FORMATETC parameter. The functions fail even if the
object server supports at least one of the TYMED values specified.

STATUS

Microsoft has confirmed this to be a problem in version 2.01 of the OLE
libraries. We are researching this problem and will post new information
here in the Microsoft Knowledge Base as it becomes available.

This is not a problem in 32-bit OLE.
Additional reference words: 2.01

KBCategory: kbole kbbuglist
KBSubcategory: LeTwoCom



BUG: OLERENDER_ASIS Results in Blank Embedded Object

PSS ID Number: Q110714
Authored 27-Jan-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

If an OLE 1.0 client application contains an embedded object and copies the
object to the clipboard and an OLE 2.0 container application then performs
a paste operation by creating a new embedded object based on the clipboard
data by calling OleGetClipboard() and then calling OleCreateFromData (), the
resulting embedded object appears blank in the container's document if the
OLE 2.0 container specifies OLERENDER ASIS as the renderOpt parameter to
OleCreateFromData () .

CAUSE

The OLE 1.0 compatibility layer has placed the CF_EMBEDSOURCE format onto
the clipboard on behalf of the OLE 1.0 client application. This is
incorrect. When copying an embedded object to the clipboard, the
CF_EMBEDDEDOBJECT format should be supplied.

NOTE: The DOBJVIEW test application supplied with the OLE Software
Development Kit (SDK) version 2.01 can be used to determine which clipboard
formats are supplied by the clipboard data object.

RESOLUTION

An OLE 2.0 container application can avoid specifying OLERENDER ASIS as the
renderOpt parameter to OleCreateFromData () when the clipboard data object
does not supply the CF EMBEDDEDOBJECT format.

STATUS

Microsoft has confirmed this to be a problem in the products listed at the
beginning of this article. We are researching this problem and will post
new information here in the Microsoft Knowledge Base as it becomes
available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoCdt






BUG: Paste Link Disabled Across the Network

PSS ID Number: Q108939
Authored 20-Dec-1993 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

The OleQueryLinkFromData application programming interface (API) function
returns failure when clipbook data from another machine is copied to the
local clipboard, even if the clipbook contains all of the data needed to
create a link.

CAUSE

cflLinkSource is not being rendered by the OLE libraries when data is being
transferred via NetDDE.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

Reference words: 2.01 3.50 4.00 Paste Link
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoDdc



BUG: Paste-Linking a 256-Color Paintbrush Object

PSS ID Number: Q111612
Authored 14-Feb-1994 Last modified 16-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries for Windows NT, version 2.1

SYMPTOMS

A 256-color bitmap is loaded into Microsoft Paintbrush version 3.11
(included with Windows 3.11) and 3.50 (included with Windows NT 3.5). The
image is selected and then copied to the clipboard. An OLE 2.0 application
then pastes a link to the object from the clipboard. To perform the paste-
link operation, the container calls OleCreateLinkFromData (), specifying
OLERENDER FORMAT as the rendering option and CF DIB as the desired format.

The resulting link object in the OLE 2.0 application has an incorrect
appearance, such as being colored solid black.

STATUS

Microsoft has confirmed this to be a problem with the Object Linking and
Embedding libraries version 2.01. We are researching this problem and will
post new information here in the Microsoft Knowledge Base as it becomes
available.

MORE INFORMATION

Normally an OLE 2.0 application will specify OLERENDER DRAW as the
rendering option. This allows OLE to cache a metafile presentation for the
object. When a metafile is cached, the 256-color Paintbrush object is
displayed correctly.

Additional reference words: 2.00 2.01 2.10 3.50
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoApp



BUG: Printing Does Not Work from CL2TEST.EXE

PSS ID Number: Q112413
Authored 08-Mar-1994 Last modified 16-May-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.01

- Microsoft Visual C++ 32-bit Edition, versions 2.0 and 2.1
- Microsoft Win32 Software Development Kit (SDK), version 3.5

SYMPTOMS

Printing does not work correctly from CL2TEST.EXE or CL32TEST.EXE.

Print from the File menu results in a blank printout.

CAUSE

Printing has not been correctly implemented in the test container
application.

STATUS

Microsoft has confirmed this to be a problem in the CL2TEST test

Choosing

application included with the Microsoft products listed at the beginning of
this article. We are researching this problem and will post new information

here in the Microsoft Knowledge Base as it becomes available.

Additional reference words: 2.00 2.01 2.10 3.50
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: Relative Monikers and OLE 1.0 Link Objects

PSS ID Number: Q111609
Authored 14-Feb-1994 Last modified 21-Apr-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
SYMPTOMS

When a link object from an OLE 2.0 application is copied to the clipboard
and then pasted into an OLE 1.0 application, the OLE 2.0 emulation layer
preserves the object's relative moniker. If the OLE 1.0 application
document is closed and then reopened by an OLE 2.0 version of the
application, OLE 2.0 will create a full moniker for the linked object by
appending the preserved relative moniker to the file moniker for the
document. This full moniker will be incorrect, because it will point to the
new document rather than to the first OLE 2.0 application's document that
contains the original linked object.

However, OLE 2.0 will still be able to bind to the linked object by
following the absolute moniker that is also stored with the object
(providing that the absolute location of the original linked object has not
changed) . At the time of this binding, OLE will then correct the full
moniker for the object.

STATUS

Microsoft has confirmed this to be a problem with the Object Linking and
Embedding libraries version 2.01. We are researching this problem and will
post new information here in the Microsoft Knowledge Base as it becomes
available.

Additional reference words: 2.10 buglist2.01
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG: Retaining Clipboard IDataObject Causes Unexpected Result

PSS ID Number: Q109545
Authored 04-Jan-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

An application holding on to a clipboard IDataObject pointer, and making
repeated calls to IDataObject::EnumFormatEtc () through that pointer, may
find that the set of formats returned by EnumFormatEtc () changes between
calls.

RESOLUTION

As noted in the Object Linking and Embedding SDK version 2.01
documentation, an application that calls OleGetClipboard() to retrieve an
IDataObject interface pointer should hold on to that IDataObject pointer
only for a very short time.

STATUS

Microsoft has confirmed this to be a problem in the products listed at the
beginning of this article. We are researching this problem and will post
new information here in the Microsoft Knowledge Base as it becomes
available.

MORE INFORMATION

Steps to Reproduce

1. Copy an object from an OLE 1.0 server to the clipboard.

2. Call OleGetClipboard() to obtain an IDataObject pointer to the
clipboard object.

3. Call IDataObject::EnumFormatEtc () to enumerate the available formats.

4. Without calling IDataObject::Release(), copy an object from an OLE 2.0
server to the clipboard.

5. Call IDataObject::EnumFormatEtc () again. The formats enumerated have
changed to the formats provided by the new OLE 2.0 object.



The OLE2UI library's implementation of the Paste Special dialog box
(provided in the Object Linking and Embedding SDK version 2.01) works
around this problem. The Paste Special dialog box is launched by calling
OleUIPasteSpecial (). If the user changes the contents of the clipboard
while this dialog is up, the OLE2UI code detects the change and responds by
ending the dialog box. When this happens, 0leUIPasteSpecial () returns

OLEUI PSERR CLIPBOARDCHANGED.

The dialog box detects changes to the clipboard contents by calling
SetClipboardViewer () to splice itself into the clipboard viewer chain.

Additional reference words: 2.01 3.50 4.00 toolkit
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoDdc



BUG: Set Line Height on ISvrOutl Object Causes GPF in Cl2Test

PSS ID Number: Q108930
Authored 20-Dec-1993 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

In certain circumstances, editing the Line Height of an ISvrOutl object
embedded within Cl2Test results in a general protection (GP) fault after
displaying the following message:

GDI - An error has occurred in your application. If you choose Ignore,
you should save your work in a new file. If you choose Close, your
application will terminate.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

MORE INFORMATION

Steps to Reproduce

Launch ISvrOutl, create a line item.
Edit/Copy the line.

Launch CL2TEST.EXE.

Edit/Paste.

Edit/Outline/Open or double-click the object.
Within ISvrOutl, Line/Set Line Height.

Enter 1 in the height field, choose OK.

~ oUW N

Additional reference words: 2.01 3.50 4.00 In Place Inplace sample gpf gp-
fault

KBCategory: kbole kbbuglist

KBSubcategory: LeTwoTls



BUG: SR2TEST Menu Items Enabled Incorrectly

PSS ID Number: Q109546
Authored 04-Jan-1994 Last modified 17-May-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51
- Microsoft Windows 95

SYMPTOMS

During an in-place activation session, SR2TEST sometimes incorrectly
enables menu items on its Edit menu.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here as it becomes available.

MORE INFORMATION

Steps to Reproduce Problem

1. Start SR2TEST.

2. Start CL2TEST.

3. Create a new CL2TEST document.

4. Insert an SR2TEST object in-place into the CL2TEST document.

5. While the SR2TEST object is still in-place active within CL2TEST, choose
Delete from the Edit menu to delete the shape.

At this point, the Cut, Copy, and Delete menu items on the Edit menu are
still enabled. This is incorrect because there is no shape remaining in the
SR2TEST object to cut, copy, or delete.

Additional reference words: 2.01 3.50 4.00 toolkit
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: SR2TEST Won't Close After Editing Link Object

PSS ID Number: Q108935
Authored 20-Dec-1993 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

After editing a linked SR2TEST object from CL2TEST, SR2TEST fails to shut
down after first displaying the following message box:

Error Document not unlocked. Attempt Self-unlocking?

CAUSE

The BindToSource button from the Properties dialog box was chosen in
CL2TEST before running the object. CL2TEST is not properly releasing the
bind context, locking SR2TEST open.

STATUS

Microsoft has confirmed this to be a problem in the CL2TEST test
application shipped with the OLE Toolkit version 2.01. We are researching
this problem and will post new information here as it becomes available.

This is not a problem with CL32TEST included with the 32-bit OLE libraries.
Additional reference words: 2.01

KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: Status Bar Not Redrawn With SR2TEST When In-Place

PSS ID Number: Q109541
Authored 04-Jan-1994 Last modified 24-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

After inserting an SR2TEST object into the in-place version of the OUTLINE
sample application, the status bar will not be redrawn until the container
application's window is resized.

STATUS

Microsoft has confirmed this to be a problem in the SR2TEST sample
application included with the OLE SDK version 2.01. We are researching this
problem and will post new information here in the Microsoft Knowledge Base
as it becomes available.

This is not a problem with SR32TEST included with the 32-bit OLE libraries.

MORE INFORMATION

Steps to Reproduce

Run ICNTOUTL.EXE.

Choose Insert Object from Edit menu.

Choose OleTest SrTest 2.0 Shape from the list box.
Choose OK.

Resize the container window.

g w N

Additional reference words: 2.01 In Place Inplace
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: SVROUTL Link Not Displayed Correctly in CNTROUTL

PSS ID Number: Q110871
Authored 01-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

Selecting the Paste Link menu item in the CNTROUTL sample application does
not correctly display the contents of the link if the source application is
the SVROUTL sample application.

This problem occurs only if the information created in SVROUTL is edited
further after the Edit Copy operation in SVROUTL, but before the Paste Link
operation in CNTROUTL. In this situation, the resulting link object is
displayed as originally copied to the clipboard, and does not reflect the
changes made after the copy operation.

STATUS

Microsoft has confirmed this to be a problem with the CNTROUTL and SVROUTL
samples included with the Microsoft products listed at the beginning of
this article. We are researching this problem and will post new information
here as it becomes available.

MORE INFORMATION

This problem occurs only when the SVROUTL link object is first pasted into
CNTROUTL. After the initial paste operation, any further modifications to
the information in SVROUTL are correctly reflected in the display of the
linked object in CNTROUTL.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoTls



BUG: Windows OLE DLLs Do Not Convert Mac OLESTREAM

PSS ID Number: Q112412
Authored 08-Mar-1994 Last modified 21-Apr-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01

SYMPTOMS

The OLE 2.01 libraries will not convert a Mac OLESTREAM to a Windows
OLESTREAM. Similarly, the Windows OLE dynamic-link libraries (DLLs) will
not convert a Mac IStorage to a Windows OLESTREAM.

STATUS

Microsoft has confirmed this to be a problem in the OLE SDK version 2.01.
We are researching this problem and will post new information here in the
Microsoft Knowledge Base as it becomes available.

MORE INFORMATION

The Macintosh OLE 2.0 libraries will be able to convert non-Macintosh
OLESTREAMs by means of OleConvertOLESTREAMToIStorage. At this time, there
are no known Macintosh OLE 1.0 applications that generate Windows-
compatible files that contain Mac OLESTREAMs.

Additional reference words: 2.01 buglist2.01
KBCategory: kbole kbbuglist
KBSubcategory: LeTwoArc



BUG:IOleObject::IsUpToDate Returns Wrong Value for Manual

PSS ID Number: Q111655
Authored 15-Feb-1994 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

SYMPTOMS

To determine whether an OLE link needs to be updated, an OLE 2.0 container
application needs to call IOleObject::IsUpToDate. If this method returns

S _FALSE, the link needs to be updated; otherwise, the link can be
considered up to date. However, calling IOleObject::IsUpToDate on a manual
link while the link server is not running results in an a return value of
S _FALSE, even 1if the link is current. The result of this is that OLE 2.0
container applications may update links unnecessarily.

STATUS

Microsoft has confirmed this to be a problem in the Microsoft products
listed at the beginning of this article. We are researching this problem
and will post new information here in the Microsoft Knowledge Base as it
becomes available.

Additional reference words: 2.01 3.50 4.00
KBCategory: kbole kbbuglist
KBSubcategory: LeTwolLnk



CLEANDB.EXE Not Included in OLE 2.01 SDK

PSS ID Number: Q109431
Authored 04-Jan-1994 Last modified 21-Apr-1995

The information in this article applies to:
- Microsoft OLE Libraries for Windows and Win32s, version 2.01

The Registration Database Cleaner (CLEANDB.EXE), which shipped with the OLE
2.0 SDK, is no longer shipped in version 2.01 of the OLE SDK.

CLEANDB.EXE was used to remove keys from the registration database that
were added by pre-release versions of OLE 2.0 but not used in the final
version. Because these keys are obsolete, CLEANDB.EXE was removed from the
OLE SDK in version 2.01.

Additional reference words: 2.01
KBCategory: kbole kbprg
KBSubcategory: LeTwoTls



Containers Should Not Query for I10leInPlaceActiveObject

PSS ID Number: Q98678
Authored 11-May-1993 Last modified 17-May-1995

The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.0
- Microsoft OLE Libraries, included with:

- Microsoft Windows NT, versions 3.5 and 3.51

- Microsoft Windows 95

OLE (object linking and embedding) version 2.0 container applications
should never call QueryInterface to get a pointer to the
IOleInPlaceActiveObject interface. Instead, the container should
AddRef () the pointer passed to IOleInPlaceUIWindow::SetActiveObject
and save it until needed.

Consider the scenario in which a nested object is currently inplace
active; that is, the container contains an object and this contained
object in turn holds another object that is inplace active. The
container has a pointer only to the "outer" object, and is not aware
of the "inner" object. Calling QueryInterface to get a pointer to
IOleInPlaceActiveObject is meaningless on the outer object because the
outer object is not currently inplace active. The only reliable way to
get a pointer to the correct IOleInPlaceActiveObject interface is
through IOleInPlaceUIWindow::SetActiveObject.

Objects capable of inplace activation should guard against this case,
and never return IOleInPlaceActiveObject from QueryInterface.

Additional reference words: 2.00 3.50 4.00
KBCategory: kbole kbprg
KBSubcategory: LeTwolInp



Corrections for Inside OLE 2 Sample Code
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The information in this article applies to:

- Microsoft OLE Libraries for Windows and Win32s, version 2.01
- Microsoft OLE Libraries, version 2.1, included with:
- Microsoft Windows NT, version 3.5

SUMMARY

The sample code for the book "Inside OLE 2," by Kraig Brockschmidt
(Microsoft Press) was originally written to be compatible with OLE 2.0.
This code has been updated to be compatible with OLE 2.01, and also to fix
some problems in the original code. This article describes the changes that
were made in updating the code. The changes are described in detail in the
"More Information" section of this article below; below a quick list of the
problems that required changes:

- Compiler Errors on IViewObject::Draw()

- Compiler Errors on 0OleUIAddVerbMenu ()

- Compiler Errors on OleStdGetObjectDescriptorFromOleObject ()
- Compiler Errors on IDS CLOSE

- Linker Fails with CLASSLIB Sample

- Compiler Errors Referencing GETICON.H

- Incorrect Prototypes for LibMain () and WEP ()

- Patron GP Faults During Activate As

- Patron's Convert To Fails

- CLASSLIB String Allocations Fail with Some Compilers

- CImpIPolyline::WriteToFile() Returns an Incorrect Value

- CImpIOleObject::GetClientSite() Returns an Incorrect Value
- Polyline Registers a Format with an Uninitialized String

- DataTran Reference Counting Problem

- Component Cosmo Fails to Release Polyline Object

- Cosmo Fails to Load When Used with HCosmo Handler

- Patron Does Not Work with Some Printer Drivers

- ClassLib Creates Table of Invalid String Pointers

- Errors in Enumerator Samples

- Samples GP Fault When Closing Iconized Documents

Updated Sample Code Available

The INOLE2 Software Library sample contains a complete source tree for
updated "Inside OLE 2" sample code. All of the changes described in this
article have already been made to the INOLEZ2 code.

The easiest way to update all of the "Inside OLE 2" samples is to get a
completely new source tree from INOLE2, and then rebuild the samples from
scratch under OLE 2.01. This article can then be used as a reference,
explaining what changes were made and why there were necessary.



INOLE2 can be downloaded as a self-extracting file from the Microsoft
Software Library (MSL) on the following services:

- CompuServe
GO MSL and download INOLEZ2.EXE

- Microsoft Download Service (MSDL)
Dial (206) 936-6735 to connect to MSDL
Download INOLEZ.EXE

- Internet (anonymous FTP)
ftp ftp.microsoft.com
Change to the \softlib\mslfiles directory
Get INOLEZ2.EXE

NOTE: This archive contains subdirectories, be sure to use the -d command
lin